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Copyrights

Copyright © 2009 LaCie. All rights reserved. 
No part of this publication may be repro-
duced, stored in a retrieval system, or trans-
mitted in any form or by any means, elec-
tronic, mechanical, photocopying, recording 
or otherwise, without the prior written consent 
of LaCie.

Trademarks

Apple, Mac, and Macintosh are registered 
trademarks of Apple Computer, Inc. Mi-
crosoft, Windows XP, Windows Vista, and 
Windows 7 are registered trademarks of Mi-
crosoft Corporation. Other trademarks men-
tioned in this manual are the property of their 
respective owners.

Changes

The material in this document is for infor-
mation only and subject to change without 
notice. While reasonable efforts have been 
made in the preparation of this document to 
assure its accuracy, LaCie assumes no liabil-
ity resulting from errors or omissions in this 
document, or from the use of the information 
contained herein. LaCie reserves the right to 
make changes or revisions in the product de-
sign or the product manual without reserva-
tion and without obligation to notify any per-
son of such revisions and changes.

Canada Compliance Statement

This Class A digital apparatus meets all re-
quirements of the Canadian Interference-
Causing Equipment Regulations.

FCC Statement

NOTE: This equipment has been tested and 
found to comply with the limits for a Class 
B digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to pro-
vide reasonable protection against harmful 
interference in a residential installation. This 
equipment generates, uses and can radiate 
radio frequency energy and, if not installed 
and used in accordance with the instructions, 
may cause harmful interference to radio com-
munications. However, there is no guarantee 
that interference will not occur in a particu-
lar installation. If this equipment does cause 
harmful interference to radio or television re-
ception, which can be determined by turning 
the equipment off and on, the user is encour-
aged to try and correct the interference by 
one or more of the following measures:

 ■ Reorient or relocate the receiving an-
tenna.

 ■ Increase the separation between the 
equipment and receiver.

 ■ Connect the equipment into an outlet on 
a circuit different from that to which the 
receiver is connected.

 ■ Consult the dealer or an experienced ra-
dio/TV technician for help.

 ■ Modifications to this product not autho-
rized by LaCie could void the FCC & In-
dustry Canada regulations and negate 
your authority to operate the product.

Manufacturer’s Declaration 
for CE Certification

We, LaCie, solemnly declare that this prod-
uct conforms to the following European 
standards: Class B EN60950, EN55022, 
EN50082-1, EN61000-3-2

With reference to the following conditions: 
73/23/EEC Low Voltage Directive; 89/336/
EEC EMC Directive

ROHS Compliance

This product is ROHS compliant (European 
Directive 2002/95/EC on the Restriction of 
Hazardous Substances).

CAUTION: Modifications not authorized by 
the manufacturer may void the user’s author-
ity to operate this device.

CAUTION: The LaCie Internet Space 2’s 
warranty may be void as a result of the failure 
to respect the precautions listed above.

NOTE: The main cable must be in confor-
mity with CEI 60227 or CEI 60245 and the 
type of plug must match the standards in the 
country of use.

Tested to comply with FCC stan-
dards for home or office use

LaCie Internet Space 2
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This symbol on the product or 
on its packaging indicates that 
this product must not be dis-
posed of with your other house-
hold waste. Instead, it is your 

responsibility to dispose of your waste equip-
ment by handing it over to a designed collec-
tion point for the recycling of waste electrical 
and electronic equipment. The separate col-
lection and recycling of your waste equip-
ment at the time of disposal will help to con-
serve natural resources and ensure that it is 
recycled in a manner that protects human 
health and the environment. For more infor-
mation about where you can drop off your 
waste equipment for recycling, please contact 
your local city office, your household waste 
disposal service, or the shop where you pur-
chased the product.

Health and Safety Precautions
 ■ Only qualified persons are authorized to 

carry out maintenance on this device.

 ■ Read this User Manual carefully and fol-
low the correct procedure when setting up 
the device.

 ■ Do not open your LaCie Internet Space 
2 or attempt to disassemble or modify 
it. Never insert any metallic object into 
the drive to avoid any risk of electrical 
shock, fire, short-circuiting or danger-
ous emissions. Your LaCie Internet Space 
2 contains no user-serviceable parts. If 
it appears to be malfunctioning, have it 
inspected by a qualified LaCie Technical 
Support representative.

 ■ Never expose your device to rain, or use it 
near water, or in damp or wet conditions. 
Never place objects containing liquids on 
the LaCie Internet Space 2, as they may 
spill into its openings. Doing so increases 
the risk of electrical shock, short-circuit-
ing, fire, or personal injury.

 ■ Power requirements 100-240 V~, 0.9 
A, 50-60 Hz, (Supply voltage fluctuations 
not exceeding ± 10% of the nominal, 
transient over-voltages according to over-
voltage category II).

General Use Precautions
 ■ Do not expose the LaCie Internet Space 

2 to temperatures outside the range of 5° 
C to 35° C (41° F to 95° F); or to op-
erational humidity beyond 5-80%, non-
condensing, or non-operating humidity 
beyond 10-90%, non-condensing. Doing 
so may damage the LaCie Internet Space 
2 or disfigure its casing. Avoid plac-
ing your LaCie Internet Space 2 near a 
source of heat or exposing it to sunlight 
(even through a window). Inversely, plac-
ing your LaCie Internet Space 2 in an en-
vironment that is too cold or humid may 
damage the unit.  Because of heat issues, 
LaCie recommends that users do not 
stack multiple Internet Space 2 together.

 ■ Always unplug the LaCie Internet Space 2 
from the electrical outlet if there is a risk 
of lightning or if it will be unused for an 
extended period of time. Otherwise, there 
is an increased risk of electrical shock, 
short-circuiting or fire.

 ■ Use only the power supply shipped with 
the device.

 ■ Do not use the LaCie Internet Space 2 
near other electrical appliances such as 
televisions or radios. Doing so may cause 
interference which will adversely affect the 
operation of the other products.

 ■ Do not place the LaCie Internet Space 
2 near sources of magnetic interfer-
ence, such as computer displays, tele-
visions or speakers. Magnetic inter-
ference can affect the operation and 
stability of your LaCie Internet Space 2. 
Do not place heavy objects on top of the 
LaCie Internet Space 2.

 ■ Never use excessive force on your LaCie 
Internet Space 2. If you detect a problem, 
see the Troubleshooting section in this 
manual.

IMPORTANT INFO: Any loss, corruption 
or destruction of data while using a LaCie 
drive is the sole responsibility of the user, and 
under no circumstances will LaCie be held 
liable for the recovery or restoration of this 
data. To help prevent the loss of your data, 
LaCie highly recommends that you keep 
TWO copies of your data; one copy on your 

external hard disk, for instance, and a sec-
ond copy either on your internal hard disk, 
another external hard disk or some other 
form of removable storage media. LaCie of-
fers a complete line of CD and DVD drives. If 
you would like more information on backup, 
please refer to our website.

IMPORTANT INFO: 1GB = 1,000,000,000 
bytes. 1TB = 1,000,000,000,000 bytes. 
Once formatted, the actual available storage 
capacity varies depending on operating envi-
ronment (typically 10% less).

IMPORTANT INFO: Some enhancements 
brought to the product during its lifetime may 
cause discrepancies between the information 
and screenshots in the manual and the actual 
user experience.

CAUTION: Modifications not authorized by 
the manufacturer may void the user’s author-
ity to operate this device.

CAUTION: A shielded-type power cord is 
required in order to meet FCC emission limits 
and also to prevent interference to the nearby 
radio and television reception. It is essential 
that only the supplied power cord be used.
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1. Introduction

Congratulations! As the owner of a LaCie Internet Space, you’ve 
taken the latest step in expanding your digital life. All of your digi-
tal media – photos, videos, music and computer files – will now 
be available anywhere at home and wherever you have an Internet 
connection, whenever you want to access it.

The Internet Space 2’s universal accessibility is achieved thanks to 
the HipServ software, which will allow you to launch the browser-
based administration and to transfer files to the drive from your 
computer.  Once the drive is plugged in and the software has been 
installed, you’re ready to transfer and share files.

 

Click a topic:
 ■ Setting Up the Internet Space 2

 ■ Connecting to Your Web Portal

 ■ Uploading Files

Quick Links
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1.1.1. Windows
 ■ Computer with an Ethernet network adapter

 ■ Windows XP SP2, Windows Vista™, Windows 7 or higher 

 ■ Minimum free disk space: 600MB recommended

 ■ Ethernet switch or router

 ■ Web browsers: Internet Explorer™ 6.0 or higher, Firefox™ 1.5 or 
higher, Chrome 2.0 or higher

1.1.2. Mac
 ■ Computer with an Ethernet network adapter

 ■ Mac OS 10.4, Mac OS 10.5, Mac OS 10.6 or higher

 ■ Minimum free disk space: 600MB recommended

 ■ Ethernet switch or router

 ■ Web browsers: Firefox™ 1.5 or higher, Safari™ 2.0 or higher, 
Chrome 2.0 or higher

 

IMPORTANT INFO: The LaCie Internet Space 2’s performance 
can be affected by such external forces as network activity, hard-
ware, distance, and setup.

IMPORTANT INFO: For optimal performance, use a gigabit Eth-
ernet router and a gigabit Ethernet board in your host computer.

1.1.3. Router
Your router directs local data traffic through your home network, 
and passes Internet data through a firewall. The firewall protects 
your computer from malicious data on the Internet, but allows safe 
data through ports. The LaCie Internet Space 2 requires ports 21 
(FTP), 22 (SSH), 80 (HTTP) and 443 (HTTPS) to be available and 
unblocked.

The Setup program will automatically configure these ports using 
UPnP (Universal Plug and Play). Most routers have UPnP available 
and enabled, allowing configuration to occur. The Setup program 
will tell you whether configuration was successful.

 ■ If UPnP is available but disabled, enable UPnP as described in 
the router documentation.

 ■ If UPnP is not available, set up port forwarding from ports 21, 
22, 80 and 443 to HipServ as described in the router documen-
tation. Use TCP for each port.

You can find a Test Port Forwarding tool at:

www.axentra.com/support/documentation/router/testportforward.
html

If you need to test port forwarding, go to this site, and then click the 
Test Port Forwarding button.

1.1. Minimum System Requirements
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1.2. Box Content
1. LaCie Internet Space 2

2. External power supply

3. Ethernet cable

4. Quick Install Guide

5. Utilities CD-ROM

IMPORTANT INFO: Please save your packaging. In the event that 
the drive should need to be repaired or serviced, it must be returned 
in its original packaging.
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1.3. Views of the Drive

1.3.1. Rear View
1. Power button

2. Power supply

3. Ethernet port

4. USB port (for external hard drive connection)

 

Fig. 01 
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1.4. LED Behavior
The front LED changes to indicate different drive behavior (Fig. 02).  
The following table sums up these behaviors.

LED Behavior Indication

Off Drive is turned off

Blue: Fast blinking Drive is initializing

Blue: Static Drive is ready

Blue: Flickering Disk access

Red: Static Failure

 
Fig. 02 
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Included Software

System Software: Axentra HipServ™

Desktop Software: HipServ™ Desktop Agent, QuickConnect, 
Desktop Mirror (Backup & Sync) for Windows and Mac

Supported Media Formats*

Media Type Supported Formats

Image JPEG, GIF, PNG

Audio MP3

Video MPEG-4 (H.264), MOV, FLV

* HipServ treats other file types not in this lists as documents. De-
pending on browser settings, they can be downloaded, or opened 
using third party applications.  Depending on the file type, you may 
be able to play back the file in your browser if you have installed an 
appropriate third party plugin.

Mobile devices

A variety of mobile devices (i.e. smart phones) can access 
HipServ. Mobile devices include Playstation Portable, iPhone, 
Blackberry, etc.

Mobile devices accessing HipServ over the Internet will auto-
matically be re-directed to a mobile interface. HipServ will auto-
matically optimize the mobile interface for the device. Depend-
ing on the device, mobile users can:

 ■ Browse albums

 ■ Browse folders in the Media Library

 ■ Create a new folder in the Media Library

 ■ Upload a file from the mobile device to a folder in the Media 
Library

 ■ Download a file from an album or folder to the mobile de-
vice

Once you set up the LaCie Internet Space 2, you can access it 
from a mobile device by going to http://www.myhipserv.com/
mobile.

Media Players

The media server built into the LaCie Internet Space 2 makes 
content available to a wide variety of media players on your 
home network. The media player must support the UPnP-AV 
(Universal Plug and Play - Audio Visual), DLNA (Digital Living 
Network Alliance) or Windows Media Connect standard. Media 
players include gaming consoles (Xbox 360 and PS3), digital 
photo frames, iTunes clients, IP televisions, networked sound 
systems (Sonos), digital video players (Roku, NETGEAR Digital 
Entertainer, DLink DSM), and many more.

Services

 ■ iTunes: Apple iTunes software installed on your computer, 
connected on your home network,  can access music stored 
on the LaCie Internet Space 2. The music files must be within 
folders or albums that are configured to share with DMAs 
or media players. Music files appear in the SHARED > 
HipServ:iTunes folder.

 

1.5. Specifications and Services
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Follow these steps to get your Internet Space 2 up and running:

2.1. Power on the Drive

2.2. Setup and Personal Portal Creation

Once you’ve completed these installation steps, move on to section 
3. Connecting to Your Web Portal.

 

2. Setting Up the Internet Space 2
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2.1. Power on the Drive
1. Connect the power supply to a wall outlet and to the LaCie 

Internet Space 2 (Fig. 03).

2. Connect the Ethernet cable to the Ethernet port on the back of 
the LaCie Internet Space 2 (Fig. 04).  Connect the other end of 
the Ethernet cable into an available Ethernet “out” port on your 
router or hub (refer to your router or hub’s documentation if 
necessary).

3. Push and hold the power button until the blue LED turns on, then 
off, then on again, then release the button.  The blue LED will 
blink while the Internet Space 2 launches its services (Fig. 05).  
When the light stops blinking, the drive is ready for setup.

Move on to 2.1. Power on the Drive.

CAUTION: Only use the AC adapter supplied with your specific 
LaCie device. Do not use a power supply from another LaCie device 
or another manufacturer. Using any other power cable or power 
supply may cause damage to the device and void your warranty. 
Always remove the AC adapter before transporting your LaCie drive. 
Failure to remove the adapter may result in damage to your drive 
and will void your warranty.

TECHNICAL NOTE: You may use your LaCie drive when in a for-
eign country thanks to its 100-240 Volt power supply. To be able to 
use this feature, you may need to purchase an appropriate adapter 
or cord. LaCie accepts no responsibility for any damage to the drive 
resulting from the use of an inappropriate adapter. Using an adapt-
er other than one authorized by LaCie will void your warranty.

 

Router or hub

IN

OUT

Fig. 03 

Fig. 04 

Fig. 05 
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2.2. Setup and Personal Portal 
Creation

In this step, you will set up the drive to register it with the service pro-
vider, prepare it for use on the home network, and make it available 
for remote use across the Internet.

IMPORTANT INFORMATION: Before you start, make sure your 
router is working and connected to the Internet and that you can ac-
cess the Internet from the computer you’ll use to set up your LaCie 
Internet Space 2.

IMPORTANT INFORMATION: If your router is not UPnP-en-
abled, access your router interface and make sure the following 
ports are unblocked (for details, refer to your router documentation 
or to your Internet provider): port 80 (http) or 443 (https) and port 
22 (ssh).

1. Insert the Setup & Utilities CD-ROM into your computer.  The 
Setup Wizard will appear automatically.  If you do not see this 
screen, double-click the CD-ROM icon in My Computer/Com-
puter (Windows) or on the Desktop (Mac).

2. Click Step 1 and follow the on-screen instructions to register the 
product and create your personal web portal.

During this process you will need the HipServ™ product key, 
which you will find on the Setup & Utilities CD-ROM sleeve (Fig. 
07). Keep the CD and key so you can reinstall the software in 
the future if necessary. Keep the portal name, username and 
password you’ve created in a safe place.

continued on the next page >>

Fig. 06 

Fig. 07 

Installed Desktop Applications

Application Function

HipServ Agent Launches the other desktop applications

HipServ 
Application

Organizes digital media into folders and 
albums

HipServ Folders Accesses digital media through Explorer/
Finder

DesktopMirror Backs up selected folders
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3. Click Step 2 and follow the instructions to install the desktop 
applications (see the chart at right for descriptions).

When steps 1 and 2 have been completed, you will see green 
check marks next to the two steps (Fig. 08).

Repeat this step on every computer on your network that you 
wish to back up onto the Internet Space 2.

TECHNICAL NOTE: Once the setup has completed, in order to 
access your LaCie Internet Space 2 remotely anywhere in the world, 
ports 1194 (or 1195) and 443 must be open on your router.

TECHNICAL NOTE: This page also contains a link for Reset Tools 
(Fig. 09), which will allow you to reinstall the software, which will 
delete all data on the drive and revert it to factory settings, or to 
reset the drive, which will return the network settings to the default 
(Fig. 10).

 

2.3. Turning Off the Drive
Click and hold the power button for three seconds.  The blue LED 
will blink while the Internet Space 2 quits its services.  As soon as the 
blue LED turns off, the drive has shut down.

 

Fig. 08 

Fig. 09 

Fig. 10 
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Whether you want to access your Internet Space 2 from your home 
network or on the road through the internet, you must connect 
through the HipServ Web Portal you created in chapter 2.

The easiest way to access the Web Portal is by using the HipServ 
agent, which you installed in chapter 2. If you want to access the 
Internet Space 2 from a computer where you’ve installed the HipServ 
Agent, see section 3.1. Home Access for details on launching the 
portal.

If you want to access the Internet Space 2 from a computer where 
you haven’t installed the HipServ Agent (i.e. you are on the road), 
see section 3.2. Away from Home Access for details on launching 
the portal.

3. Connecting to Your Web Portal

Fig. 11 

Fig. 12 
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3.1. Home Access
During the setup process in chapter 2, you installed HipServ Agent, 
which provides you a quick way to launch the other HipServ soft-
ware, including the Web portal (referred to here as the HipServ Ap-
plication). 

The HipServ Application runs in your browser. It allows you to access 
your folders and albums within the media library, view albums, and 
set preferences. Because the HipServ Application uses a web-based 
interface, it works the same with different computers and browsers. 
The HipServ Application is available if the Internet Space 2 is located 
locally on your home network, or remotely across the Internet. 

1. First, open HipServ Agent:

Windows Users: Launch the HipServ Agent from the Start 
Menu  (Start > All Programs > Axentra > HipServ Desktop 
Applications > HipServ Agent > HipServ Agent).  The icon 
will appear in your System Tray (Fig. 13).

Mac Users: Launch the HipServ Agent from the Applications 
folder (Applications > HipServ Desktop Applications).  The 
icon will appear in your Menu Bar.

2. Next, to connect to the Web Portal, click on the HipServ icon in 
the Menu Bar (Mac) or right-click the HipServ icon in the System 
Tray (Windows, Fig. 13) and select Open HipServ application.  
The HipServ Application (Web Portal) will open in your default 
web browser (Fig. 14).

NOTE: You can alternatively access the Web portal by simply navi-
gating in your browser to homelacie.com.

3. After you launch the Web Portal, you must log in (unless you 
logged in previously). Enter Your Home Server Name, Your 
User name, and Your Password. Optionally select Remember 
me, so you don’t have to re-enter your password next time you 
log in. Click Sign In.

For more information on navigating and using the Web Portal, see 
section 6. About HipServ Web Portal Interface.  For information on 
transferring files, refer to chapter 4. Uploading Files.

Fig. 13 

Fig. 14 
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3.2. Away from Home Access
Because the HipServ Application uses a web-based interface, it 
works the same with different computers and browsers. It allows you 
to access your folders and albums within the media library, view 
albums, and set preferences.  As a result, the HipServ Application 
is available if the Internet Space 2 is located locally on your home 
network, or remotely across the Internet.

1. From any broadband Internet connection, open a browser and 
navigate to homelacie.com.

2. Log in by entering Your Home Server Name, Your User name, 
and Your Password. Optionally select Remember me, so you 
don’t have to re-enter your password next time you log in. Click 
Sign In (Fig. 15).

For more information on navigating and using the Web Portal, see 
section 6. About HipServ Web Portal Interface.  For information on 
transferring files, refer to chapter 4. Uploading Files.

Fig. 15 

Fig. 16 
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HipServ provides you with several to transfer multimedia content 
from your computer to the Internet Space 2.

 ■ To transfer files via the network connection using the Finder 
(Mac) or Windows Explorer (Windows), see section 4.3. Trans-
ferring Files from a Computer via the Finder/Windows Explorer.

 ■ To transfer files using the Web Portal (HipServ Application), see 
section 4.2. Transferring Files from a Computer via the Web Por-
tal.

4.1. About Folders
When you access the storage on the Internet Space 2, you will see 
the following folders, which cannot be modified (Fig. 17):

FamilyLibrary

The FamilyLibrary folder contains the FamilyDocuments, FamilyMu-
sic, FamilyPhotos and FamilyVideos subfolders. Your family shares 
these folders, so they are accessible to all users. Note that all users 
can access the FamilyLibrary folders through Explorer/Finder, even 
if access is blocked or Windows networking is disabled. See 6.8.11. 
Add New User, and 6.8.6. Windows Networking.

MyLibrary

The MyLibrary folder contains the MyDocuments, MyMusic, MyPho-
tos and MyVideos subfolders. Each user has their own MyLibrary 
folders, and only you can access your folders. Windows networking 
must be enabled for users to see their MyLibrary folders. See 6.8.6. 
Windows Networking.

MyComputers

The MyComputers folder contains a folder for each computer using 
DesktopMirror, Vista Backup or Time Machine. You can only access 
a MyComputers folder if your login credentials were used to con-
figure the backup. Windows Networking must be enabled for users 
to see their MyComputers folders. See 6.8.6. Windows Networking.

4. Uploading Files

Fig. 17 
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4.2. Transferring Files from a 
Computer via the Web Portal

Once you’re logged in to the Web Portal, you can upload files to the 
Internet Space 2 using the Manual or Drag and Drop method.  In 
the Web Portal, simply navigate to the folder where you want the file 
to be stored and click the Upload icon  ( ) (Fig. 18). This process 
is explained in more detail in section 6.4.9. Uploading Files.

 

4.3. Transferring Files from a 
Computer via the Finder/
Windows Explorer

To accomplish this kind of transfer, the HipServ Agent will create an 
SMB connection, which will allow you to drag-and-drop your files 
from your computer to the Internet Space 2.

1. First, open HipServ Agent:

Windows Users: Launch the HipServ Agent from the Start 
Menu  (Start > All Programs > Axentra > HipServ Desktop 
Applications > HipServ Agent > HipServ Agent).  The icon 
will appear in your System Tray.

Mac Users: Launch the HipServ Agent from the Applications 
folder (Applications > HipServ Desktop Applications).  The 
icon will appear in your Menu Bar.

2. Next, to create an SMB connection, click on the HipServ icon in 
the Menu Bar (Mac) or right-click the HipServ icon in the System 
Tray (Windows) and select Explore my HipServ folders (Fig. 19).

3. This application prompts you to log in (if necessary), and opens 
Windows Explorer (Windows) or Finder (Mac). It shows your 
FamilyLibrary, MyLibrary and MyComputers folders within a net-
work drive (Fig. 19), unless access has been blocked.

You can access the folders in a familiar environment, and upload 
files greater than 2 GB. This command is available whether the In-
ternet Space 2 is located locally on the home network, or remotely 
across the Internet. For more information on HipServ Folders, see 
section 4.1. About Folders.

 

Fig. 18 

Fig. 19 

Fig. 20 
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This section describes how to connect a USB printer to the LaCie 
Internet Space 2. This way all computers on the home network can 
share the printer. Note that only printing is supported. If you have a 
multi-function printer, scanning is not supported.

5.1. Windows Users
1. Connect a USB cable from the printer to the LaCie Internet 

Space 2.

2. Using Explorer, browse to HipServ. If prompted, enter your User 
Name and Password.

3. Double-click HipServ. The following message appears.

4. Click OK. The Add Printer Wizard starts.

5. Select the Manufacturer and Printer, and then click OK.

5. Connecting a Printer

Fig. 21 

Fig. 22 

Fig. 23 
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5.2. Mac Users
1. Connect a USB cable from the printer to the LaCie Internet 

Space 2.

2. Go to System Preferences > Printer & Fax (Fig. 24).

3. Click  to add a printer.

4. Click Windows, and then select workgroup and hipserv (Fig. 
25).

5. Select Registered User, enter your User Name and Password, 
and then click Connect.

continued on the next page >>

Fig. 24 

Fig. 25 

Fig. 26 
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6. Select the printer model in Print Using, and then click Add.

The first time you print, you will be prompted for your user name and 
password. Enter your User Name and Password, select Remember 
this password in my keychain, and then click Connect. Next time you 
print, you will not be prompted for your password.

Fig. 27 
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The HipServ Application runs in your browser. It allows you to access 
your folders and albums within the Media Library, view albums, and 
set preferences. Because the HipServ Application uses a web-based 
interface, it works the same with different computers and browsers. 
The HipServ Application is available if the LaCie Internet Space 2 is 
located locally on the home network, or remotely across the Internet.

6.1. Starting the HipServ Application
You can launch the HipServ application either through the HipServ 
Agent or by typing homelacie.com into your browser. After you 
launch the HipServ Application (Web Portal), you must log in (unless 
you logged in previously) (Fig. 29). Enter Your Home Server Name, 
Your User name, and Your Password. Optionally select Remember 
me, so you don’t have to re-enter your password next time you log 
in. Click Sign In.

6.2. Landing Page and Main Menu

Landing Page
After you start the HipServ Application and log in, the Landing page 
appears. It allows you to select Albums, Media Library or Prefer-
ences. You can set a background image for the Landing page. See 
section 6.6.18. Working with Images. You can also clear the back-
ground image. See section 6.8.3. User.

Main menu
The Main menu appears at the top of the Albums page, Media Li-
brary page, and Preferences page. It shows your display name, and 
allows you to sign out. The Main menu contains the Home menu 
and the Help menu. The Home menu lets you switch to one of the 
other pages. The Help menu shows the user manual, connects to 
HipServ support or starts a Quick Tour.

NOTE: The Quick Tour is an excellent introduction to using the 
HipServ Application (Web Portal).

6. About HipServ Web Portal Interface

Fig. 28 

Fig. 29 

Fig. 30 
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6.3. Media Library page
The Media Library page allows you to organize your files using fold-
ers, and share files using albums. The Media Library page has the 
Media Sources section, Albums section, Files section and Details 
section.

6.3.1. Displaying the Media Library page
From the Landing page, click Media Library. From one of the other 
pages, click Home in the Main menu, and then select Media Library 
(Fig. 31).

6.4. Media Sources Section
The Media Sources section shows the FamilyLibrary folders (if your 
account can access them), your MyLibrary folders, and your My-
Computers folders.

Note that while the subfolders within FamilyLibrary and MyLibrary 
are intended for specific file types, you can actually put any file into 
any folder.

6.4.1. FamilyLibrary
The FamilyLibrary folder contains the FamilyDocuments, FamilyMu-
sic, FamilyPhotos and FamilyVideos subfolders. Your family shares 
these folders, so they are accessible to all user accounts on HipServ 
(unless the user’s account blocks access; see 6.8.11. Add New User. 
They are shared with DMAs (digital music adapters), making the 
content available to media players on the home network. You can 
share content within the folders with friends or the public by placing 
the files in an album.

Fig. 31 
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6.4.2. MyLibrary
The MyLibrary folder contains your private MyDocuments, MyMusic, 
MyPhotos and MyVideos subfolders. Each user has their own MyLi-
brary folders, and only you can access your folders. They can be 
shared with DMAs, making the content available to media players 
on the home network. You can share content within the folders with 
family, friends or the public by placing the files in an album.

6.4.3. MyComputers
The MyComputers folder contains a folder for each computer us-
ing DesktopMirror, Vista Backup or Time Machine. You can only 
access a MyComputers folder if your login credentials were used 
to configure the backup. Note that the directory structure within the 
MyComputers folder makes it easy to locate and restore single files 
or entire folders.

You can download them through the HipServ Application, or you 
can copy and paste them through HipServ Folders. Folders within 
MyComputers can be shared with DMAs, making the content avail-
able to media players on the network. You can share content within 
the folders with family, friends or the public by placing the files in 
an album.

 

6.4.4. Selecting a Folder
Selecting a folder highlights the folder name, and displays its sub-
folders and files in the Files section (Fig. 32).

To select a folder, click the folder name.

Fig. 32 
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Upload files

Expand folder

Add folder

Display menu
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6.4.5. Expanding and Collapsing a Folder
Expanding a folder shows its subfolders.

To expand a folder, click the right arrow ( ) beside the folder 
name.

Collapsing a folder hides its subfolders. This is useful if many folders 
are open, and you want to reduce clutter on the screen.

To collapse a folder, click the down arrow ( ) beside the folder 
name.

6.4.6. Displaying the Menu
The HipServ Application has a menu with commands for working 
with folders.

To display the menu, move the mouse over a folder. An arrow will 
appear beside the name. Click the right arrow ( ) to display the 
menu.

6.4.7. Adding a Folder
Adding a folder creates a new subfolder within the current folder. 
Using subfolders is a good way to keep your content organized. A 
new folder within FamilyLibrary will be accessible to all users (unless 
the user’s account blocks access). Only you can access a folder 
within MyLibrary.

To add a folder, select the folder where you want to add the sub-
folder, and then click the New Folder icon ( ). When prompted, 
enter the name of the folder, and then click Create.
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6.4.8. Deleting a Folder
Deleting a folder removes it and all its files and subfolders from the 
LaCie Internet Space 2. Delete folders carefully!

To delete a folder, select it, and then click the Delete Folder icon (
). You can also select the folder, display the menu, and then 

select Delete.

Note that if you delete a folder, and an album contains a reference 
to a file within the folder, the item will no longer be available from 
the album.

6.4.9. Uploading Files
Uploading files copies them from your computer to the selected 
folder. If you upload a file to a folder within FamilyLibrary, it will 
be accessible to all users (unless the user’s account blocks access). 
Only you can access a file uploaded to your MyLibrary folders.

TECHNICAL NOTE: The HipServ Application allows you to a copy 
a file or set of files that are less than 2 GB.

If you want to copy files greater than 2 GB, use HipServ Folders (4.3. 
Transferring Files from a Computer via the Finder/Windows Explorer) 
or DesktopMirror (see 7. DesktopMirror (Backup Application)).

To select the destination for the upload, select the folder, display 
the menu, and then select Upload. Alternatively, you can select the 
folder, and then click the Upload icon ( ). The Upload window 
appears. You can now choose Manual Upload or Drag and Drop. 
Manual Upload lets you select individual files, and is the default 
method. Drag and Drop lets you drag multiple files and entire fold-
ers from Explorer/Finder.

To use Manual Upload, click Manual Upload (this option is selected 
by default) (Fig. 33). Click Add File, browse to the file, and then click 
Open. Optionally add more files. Click Upload to upload the file(s). 
Once the upload is complete, click Close.

To use Drag and Drop, click Drag and Drop. A window appears, 
prompting you to drag and drop your files here (Fig. 34). Drag the 
file from Explorer/Finder and drop it into the window. You can drag 
multiple files or folders. Click Upload to upload the file. Once the 
upload is complete, close the window.

 

Fig. 33 

Fig. 34 
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6.4.10. Viewing Details
Viewing details shows information about the selected folder, and 
allows you to edit it.

To view details, select the folder, display the menu, and then select 
View Details.

Alternatively, select the folder, and then click the Show Details icon  (
). The details appear in the Details section, which is displayed be-

side the Files section. Folder details include the name of the folder, 
and the number of files and folders it contains.

6.4.11. Opening a Folder
Opening a folder shows its subfolders, and displays its subfolders 
and files in the Files section.

To open a folder, double-click the folder name. You can also dis-
play the menu, and then select Open.

 

6.4.12. Moving a Folder
Moving a folder puts it in a different location, along with its subfold-
ers and files. If the new location is within FamilyLibrary, the folder will 
be accessible to all users (unless the user’s account blocks access). 
Only you can access a folder within MyLibrary.

To move a folder, drag and drop it to another folder. You can also 
select the folder you want to move, display the menu, and then 
select Cut. Select the destination folder, display the menu, and then 
select Paste.

Note that you cannot cut and paste a folder to another application, 
and you cannot cut and paste data from another application into the 
HipServ Application.
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6.4.13. Copying a Folder
Copying a folder puts it in an additional location, along with its 
subfolders and files, while keeping the original folder. If the new 
location is within FamilyLibrary, the folder will be accessible to all 
users (unless the user’s account blocks access). Only you can access 
a folder within MyLibrary.

To copy a folder, select the folder, display the menu, and then se-
lect Copy. Select the destination folder, display the menu, and then 
select Paste.

Note that you cannot copy and paste a folder to another applica-
tion, and you cannot copy and paste data from another application 
into the HipServ Application.

6.4.14. Renaming a Folder
Renaming a folder changes its name. To rename a folder, select the 
folder, display the menu, and then select Rename. When prompted, 
enter the new name, and then click Rename.

Note that if you rename a folder, and an album contains a reference 
to a file within the folder, the item will no longer be available from 
the album. 

 

6.4.15. Adding Files to an Album
An album allows you to group related pictures, music, videos and 
documents from multiple folders. The album has a theme, which sets 
the mood by displaying background graphics. You can leave the 
album unshared for your own enjoyment, or you can share it with 
your family, friends or everyone.

An album contains references to files, but doesn’t contain copies of 
the files themselves. This way you can have the same file in multiple 
albums without taking up any more space. However, if you delete 
a file from the folder, it will no longer be available in the albums.

If you add files from a folder to an album, files within subfolders are 
not included.

Adding files to an Existing Album

You can add the contents of a folder to an existing album. To add 
the files, select the folder, display the menu, and then select Add to 
Album > [Album Name].
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Creating a New Unshared Album

You can add the contents of a folder to a new album that only you 
can see. The folder can be shared later.

To create the album, select the folder, display the menu, and then 
select Add to Album > New. By default, the album has the same 
name as the selected folder. Optionally enter the Name of the al-
bum, and optionally enter a Description. Select a theme for the al-
bum, or keep the default theme ()Fig. 35. Click Submit to create the 
album.

 

Creating a New Shared Album

You can add the contents of a folder to a new album. The album 
can be shared with family and media players on the home network, 
and with friends and the public on the Internet.

To create the album, select the folder, display the menu, and then 
select Share Selected Items (Fig. 36). By default, the album has the 
same name as the selected folder. Optionally enter the Name of the 
album, and optionally enter a Description. Select a theme for the 
album, or keep the default theme. Choose whom you want to share 
the album with, as described in the following sections. Click Submit 
to create the album.

 

6.4.16. Allowing Downloads
The album streams compressed images to conserve bandwidth and 
improve performance. You can allow people viewing the album to 
download original full-resolution versions of the files. This is espe-
cially important if the album contains documents, because the al-
bum lists these files but cannot open them.

To allow files to be downloaded, select Allow downloads for this 
album.

Fig. 35 

Fig. 36 
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6.4.17. Sharing with Family
Sharing an album with family makes it available to the other HipServ 
users, unless their account blocks access. See 6.8.11. Add New 
User. The album will appear in their Albums page.

To share the album with family, select Share with other family ac-
counts.

 

6.4.18. Sharing with Friends
Sharing an album with friends makes it available to selected con-
tacts.

To share the album with your friends, select Share with friends (Fig. 
37).

Setting the From Address

The first time you share an album with friends, HipServ will prompt 
you for your email address. Emails sent by HipServ notifying your 
friends about shared albums will indicate they are from this email 
address. Each HipServ user can set their own email address.

You can change your email address later. See 6.8.3. User.

Setting an End Date

By default, an album is shared indefinitely. Setting an end date de-
termines how long the album will be shared.

To set an end date for sharing, select Share Until. By default, the 
album will be shared for one month. Use the calendar to change 
the end date.

Limiting Access

When you share an album with friends, HipServ can send them an 
email notification that contains a link to the album. By default, any-
one who clicks the link can view the album. Limiting access allows 
you to require a password.

To limit access, select Password-protect this album. When a friend 
first clicks the link in the email notification, they are prompted to 
create a password. Next time they click the link, they are prompted 
for this password.

Fig. 37 
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Emailing your Friends

When you share an album with friends, HipServ can send them an 
email notification that contains a link to the album.

To email your friends, you must first set up your contacts, as de-
scribed below. Then you can either select Send email to invitees, or 
click Send Invitations.

6.4.19. Setting Up Contacts
Setting up contacts is setting up your address book, and setting up 
the contact list for the current album. Your address book contains 
the names and email addresses of your friends. Each user has their 
own address book. You only have to set up the address book once, 
though you can add and remove contacts later as required. The 
contact list contains friends whom you want to share the album with, 
and must be set up for each new album. Each album can be shared 
with a different set of your friends.

Viewing your Contacts

Viewing your contacts shows your address book and the contact list 
for the current album.

To view your contacts, click the click the Add Friends icon ( ) in 
the album details. The Share with your contacts window appears 
(Fig. 38).

Setting up your Address Book

To add a friend to your address book, click the Create New Contact 
icon ( ). Enter the Contact Name and Email Address, and then 
click Add. Once you add a friend to your address book, you can add 
them to the contact list.

To remove a friend from your address book, select the friend in the 
Address Book list, and then click the Delete Contact icon ( ).

To edit a friend in your address book, select the friend in the Address 
Book list, and then click the Edit Contact icon. You can then change 
their name or email address.

Fig. 38 
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Setting up the Contact List

To add a friend to the contact list, select the friend in the Address 
Book list, and then click Add >>.

To remove a friend from the contact list, select the friend in the Al-
lowed Access list, and then click << Remove. Note that if you email 
an invitation to a friend, and then remove them from the contact list, 
they will no longer have access to the album.

Finding a Friend

If you have a large list of friends, and you want to remove or notify a 
specific person, enter some letters from their name in the Find in list 
box. The Address Book list will show only matching entries.

Saving your Contacts

Once you have set up your address book or contact list, click Save.

6.4.20. Sharing with Everyone
Sharing an album with everyone makes it available to the public 
over the web. The website address will appear in the album details.

If you share an album with everyone, it will automatically be shared 
with family as well, including users without access to albums shared 
with family.

To share the album publicly, select Share with everyone.

Setting an End Date

By default, an album is shared indefinitely. Setting an end date de-
termines how long the album will be shared.

To set an end date for sharing, select Share Until. By default, the 
album will be shared for one month. Use the calendar to change 
the end date.
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6.4.21. Sharing with Media Players
Sharing files with media players allows media players on your home 
network to detect and access content within the album. The me-
dia player must support the UPnP-AV, DLNA or Windows Media 
Connect standard. Media players include gaming consoles (Xbox 
360 and PS3), digital photo frames, iTunes clients, IP televisions, 
networked sound systems (Sonos), digital video players (Roku, NET-
GEAR Digital Entertainer, DLink DSM), and many more.

To share the album with media players on your home network, select 
Share with media players.

 

6.4.22. Sharing Files with DMAs
Sharing files with DMAs (digital media adapters) allows media play-
ers on your home network to detect and access content within the 
folder. The media player must support the UPnP-AV, DLNA or Win-
dows Media Connect standard. Media players include gaming con-
soles (Xbox 360 and PS3), digital photo frames, iTunes clients, IP 
televisions, networked sound systems (Sonos), digital video players 
(Roku, NETGEAR Digital Entertainer, DLink DSM), and many more.

To share folder with media players, select the folder, display the 
menu, and then select Share with DMA. All its subfolders will be 
shared as well.

To stop a folder from sharing with media players, select the folder, 
display the menu, and then select Unshare with DMAs. You can then 
enable or disable sharing for its individual subfolders.

Note that files are shared with media players if they are in a folder 
or album with sharing enabled.

6.4.23. Running a Slideshow
Running a slideshow displays the images within the folder, one at a 
time. Images within subfolders are not shown, nor are music, videos 
and documents.

To run a slideshow, select the folder, display the menu, and then 
select Slideshow. The browser automatically shows each image with 
its caption. See 6.4.23. Running a Slideshow.
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6.4.24. Playing Songs
Playing songs plays the music within the folder. Songs within sub-
folders are not played, nor are images, videos and documents.

To play songs, select the folder, display the menu, and then select 
Autoplay. The browser automatically plays each song, and shows 
the album art and name of the current song. See 6.4.24. Playing 
Songs.

6.4.25. Downloading a File
Downloading a file retrieves the original full-resolution version of 
the file. 

To download a file, select the folder, display the menu, and then se-
lect Download. A window lists the files within the folder. Files within 
subfolders are not listed. Click the Download button beside the de-
sired file. Depending on your browser settings, you can open the 
file, download it to a specific directory, or download it to the default 
directory.
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6.5. Albums Section
The Albums section shows the albums you have created, and allows 
you to edit them. To view your family’s albums (i.e. shared albums 
created by the other users), select Albums in the Home menu.

6.5.1. Selecting an Album
Selecting an album highlights the album name, and displays its files 
in the Files section.

To select an album, click the album name.

6.5.2. Displaying the Menu
The HipServ Application has a menu with commands for working 
with albums.

To display the menu, move the mouse over an album. An arrow will 
appear beside the name. Click the arrow ( ) to display the menu.

6.5.3. Viewing Details
Viewing details shows information about the selected album, and 
allows you to edit it.

To view details, select the album, display the menu, and then se-
lect View Details.  Alternatively, select the album, and then click the 
Show Details icon  ( ). The details appear in the Details section, 
which is displayed beside the Files section. Album details include the 
name of the album, the number of files it contains, the description, 
the theme, and how the album is shared.

6.5.4. Disabling Sharing
Disabling sharing prevents others from viewing your album. 

To disable sharing, select the album, and view its details. Clear the 
Album Sharing and Social Networking Sites options (Fig. 39).

 

Fig. 39 
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6.5.5. Adding an Album
To add an album, click the New Album icon  ( ). Enter the Name 
of the album and an optional Description. Select the theme, and set 
the sharing options. You can then drag and drop folders and/or files 
from folders to the album.

6.5.6. Deleting an Album
Deleting an album removes access to its files, but the files remain 
within the folders.

To delete an album, select it, and then click the Delete Album icon 
( ). You can also select the album, display the menu, and then 
select Delete.

6.5.7. Renaming an Album
Renaming an album changes its name.

To rename an album, select the album, display the menu, and then 
select Rename. When prompted, enter the new name, and then click 
Rename.

Note that if you rename an album that is shared with friends or with 
everyone, the original link will no longer work. However the link will 
go to a page listing all your albums, so they might be able to find 
the renamed album.

6.5.8. Running a Slideshow
Running a slideshow displays the images within the album, one at a 
time. Music, videos and documents are not shown.

To run a slideshow, select the album, display the menu, and then 
select Slideshow. The browser automatically shows each image with 
its caption. See 6.4.23. Running a Slideshow.
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6.5.9. Playing Songs
Playing songs plays the music within the album. Images, videos and 
documents are not played.

To play songs, select the album, display the menu, and then select 
Autoplay. The browser automatically plays each song, and shows 
the album art and name of the current song. See 6.4.24. Playing 
Songs.
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6.6. Files Section
The Files section shows the subfolders and files within the selected 
folder, or the files within the selected album.

6.6.1. Filtering Files
Filtering the files specifies which file types will appear.

To filter the files, select All Files, Images, Music or Videos in the 
Media Filter list.

The Files section will only display files of the selected type.

6.6.2. Setting the View
Setting the view controls how the Files section will display the files 
within the currently selected folder or album.

To set the view, select Thumbnail, List, or Shuffle in the Views list.

Thumbnail

Thumbnail view displays an image for each file that indicates what 
the file contains (Fig. 40). It also shows the file name, size and cap-
tion. Moving the mouse over a file in Thumbnail view shows the 
Options arrow, which allows you to display the menu.

List

List view uses a table to display the files (Fig. 41). For each file, List 
view shows the file name, whether the file has tags, caption, date, 
file type and size. Moving the mouse over a file in List view shows an 
arrow, which allows you to display the menu.

Shuffle

Shuffle view displays a larger image for each file (Fig. 42). It also 
shows the file name and caption. You can flip through the files by 
clicking the image to the left or right of the current file. The menu is 
not available in Shuffle view.

 

Fig. 40 

Fig. 41 

Fig. 42 
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6.6.3. Searching for Files and Folders
Searching for files and folders checks all the folders you have access 
to, and displays items with captions, tags or file names that match 
the search criteria.

To run a search, enter text in the Search box, and then click the 
Search icon ( ) (Fig. 43). The Files section will show files that con-
tain the search text in the caption, tags or file name. It will also show 
folders that contain the search text in the folder name. The search 
term will be highlighted. If you enter one word, you will see all the 
items that share the word. If you enter more than one word, the 
search results will be constrained to items that have all the words.

Once the files appear, you can add them to an album for sharing 
with family, friends or the public.

For example, the following illustration shows the results after search-
ing for church. The first file has Church as a tag; the tag appears in 
the Details section. The second file has Church in the caption. The 
third file has Church.jpg as the file name. See 6.6.8. Adding a Cap-
tion, and 6.6.9. Adding Tags.

 

6.6.4. Uploading a File
To upload a file, select the destination folder, and then upload the 
file. See 6.4.9. Uploading Files. You can also use HipServ Folders 
(see 4.3. Transferring Files from a Computer via the Finder/Windows 
Explorer) or or DesktopMirror (see 7. DesktopMirror (Backup Ap-
plication)).

6.6.5. Selecting a File
You can select a file in Thumbnail view or List view. Selecting a file 
highlights it, and allows you to perform an operation on it. If the 
Details section is displayed, it shows the file’s details.

To select a file, click it. To select multiple individual files, hold the 
Ctrl key while clicking files. To select a range of files, click the first 
file, and then hold the Shift key while clicking last file.

Fig. 43 
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6.6.6. Displaying the Menu
The HipServ Application has a menu with commands for working 
with files. You can display the menu in Thumbnail view or List view. 
The menu is not available in Shuffle view.

To display the menu, move the mouse over a file. In List view, an ar-
row ( ) will appear beside the name. In Thumbnail view, the Op-
tions arrow  ( ) will appear on the image. Click the arrow 
to display the menu. The menu has different commands depending 
on whether the file is within a folder or an album, and depending on 
the whether the file is an image, song, video or document.

 

6.6.7. Viewing Details
Viewing details shows information about the selected file, and allows 
you to edit it (Fig. 44).

To view details, select the file, display the menu, and then select 
View Details. Alternatively, select the file, and then click the Show 
Details icon ( ). The details appear in the Details section, which 
is displayed beside the Files section. Details for all files include the 
name, size, file type and date. If the file is within a folder, the Details 
section shows the tags and caption. Songs include the duration. 
Pictures include the dimension. Videos include the duration and the 
dimension.

 

6.6.8. Adding a Caption
Adding a caption stores a description of the file. The caption will 
appear when viewing a file within a folder or album. You can search 
for a file by entering text from its caption. See 6.6.3. Searching for 
Files and Folders.

To add a caption to a file, start by selecting its folder. Select the file, 
display the menu, and then select View Details. Enter the caption in 
the Caption box of the Details section.

Alternatively, in Thumbnail view, you can select the file, click the 
Click to add caption message, and then enter the caption. In List 
view, you can select the file, and then enter the caption into the 
Caption column.

 

Fig. 44 
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6.6.9. Adding Tags
Adding tags stores additional information about the file. The tags 
will appear in the Details section when viewing a file within a folder. 
The tags will not appear when viewing an album. You can search 
for a file by entering text from its tags. See 6.6.3. Searching for Files 
and Folders.

To add tags to a file, start by selecting its folder. Select the file, dis-
play the menu, and then select View Details. Alternatively, select the 
file, and then click the Show Details icon ( ). Enter the tags in the 
Tags box of the Details section.

Tags allow you to describe each file on your LaCie Internet Space 2. 
If you tag files consistently, you will be able to find them more easily, 
especially as their number grows over time.

For example, assume you took a number of pictures at Jane’s 11th 
birthday, which was held at your cottage. You enter the following 
tags for each picture: birthday, Jane, eleven, cottage. Some pictures 
have Mary or Joe in them, so you enter Mary or Joe as tags in those 
pictures.

Later you can search for birthday pictures. Tagged pictures from all 
birthdays will appear, including tagged pictures from Jane’s birth-
day. Or you can search for pictures from your cottage. All tagged 
pictures from the cottage will appear, including tagged pictures from 
Jane’s birthday. If you search for birthday cottage, then only birthday 
pictures from the cottage will appear.

Note that you can tag music, video and documents as well as pho-
tos.

6.6.10. Deleting a File
Deleting a file removes it from the folder. You can delete multiple 
files at once.

To delete a file, start by selecting its folder. Select the file, display the 
menu, and then select Delete.

Note that if you delete a file, and an album contains a reference to 
it, the item will no longer be available from the album.
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6.6.11. Removing a File
Removing a file deletes it from the album, but leaves the file in the 
original folder. You can remove multiple files at once.

To remove a file, start by selecting its album. Select the file, display 
the menu, and then select Remove.

6.6.12. Moving a File
Moving a file puts it in a different folder. You can move multiple 
files at once.

To move a file, start by selecting its folder, and then drag and drop 
it to another folder. You can also select the file, display the menu, 
and then select Cut. Select the destination folder, display the menu, 
and then select Paste.

Note that you cannot cut and paste a file to another application, 
and you cannot cut and paste data from another application into 
the HipServ Application.

6.6.13. Copying a File
Copying a file puts it in an additional folder, while keeping it in the 
original folder. You can copy multiple files at once. Copying a file 
duplicates the original full-resolution version stored in the folder; not 
the compressed version displayed in the HipServ Application.

To copy a file, start by selecting its folder. Select the file, display the 
menu, and then select Copy. Select the destination folder, display 
the menu, and then select Paste.

Note that you cannot copy and paste a file to another application, 
and you cannot copy and paste data from another application into 
the HipServ Application.
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6.6.14. Renaming a File
Renaming a file changes its name. You can only rename a file within 
a folder.

To rename a file, start by selecting its folder. Select the file, display 
the menu, and then select Rename. When prompted, enter the new 
name, and then click Rename.

Note that if you rename a file, and an album contains a reference to 
that file, the item will no longer be available from the album.

 

6.6.15. Adding Files to an Album
Adding a file to an album adds a reference to the file, but doesn’t 
copy the file itself. This way you can have the same file in multiple 
albums without taking up any more space. However, if you delete a 
file from the folder, it will no longer be available in the albums. You 
can add multiple files at once.

To add a file to an album, start by selecting its folder, and then drag 
and drop the file to the album.

You can also select the file, display the menu, and then select Add to 
Album > New, Add to Album > [Album Name], or Share Selected 
Items.

Note that if you select multiple files, and then select Add to Album 
> New or Share Selected Items, the album will not have a default 
name.

6.6.16. Using a File as the Album Cover
Using a file as the album cover causes its image to appear in the 
album icon on the Albums page. You can use an image, music, 
video or document. A music file will use its album art (if available). 
A document will use the generic document image.

To use a file as the album cover, start by selecting the album. Select 
the file, display the menu, and then select Use as Album Cover.
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6.6.17. Downloading a File
Downloading a file retrieves the original full-resolution version of the 
file. You can select multiple files for downloading at once.

To download a file, select it, display the menu, and then select 
Download. A window lists the selected files. Click the Download but-
ton beside the desired file. Depending on your browser settings, you 
can open the file, download it to a specific directory, or download it 
to the default directory.

6.6.18. Working with Images

Use as Landing Page Background

Using an image as the Landing page background causes it to ap-
pear on your Landing page.

To set the Landing page background, select the image, display the 
menu, and then select Use as Landing Page Background.

You can remove the image from the Landing page. See 6.8.3. User.

View

Viewing an image displays it in a paused slideshow.

To view an image, double-click it. You can also select the image, 
display the menu, and then select View.

If you play the slideshow, it will display the other images within the 
selected folder or album. See 6.4.23. Running a Slideshow.

Rotate Clockwise

Rotating an image clockwise turns it to the right. If the image is used 
in an album, it will be rotated there as well.

To rotate an image, start by selecting its folder. Select the image, 
display the menu, and then select Rotate Clockwise.

Rotate Counterclockwise

Rotating an image counterclockwise turns it to the left. If the image 
is used in an album, it will be rotated there as well.

To rotate an image, start by selecting its folder. Select the image, 
display the menu, and then select Rotate Counterclockwise.
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6.6.19. Playing a Song
Playing a song plays the music within the folder or album, starting 
with the selected song.

To play a song, double-click it. You can also select the song, display 
the menu, and then select Play. See 6.4.24. Playing Songs.

6.6.20. Playing a Video
Playing a video shows the video.

To play a video, double-click it. You can also select the video, dis-
play the menu, and then select Play. See 6.6.20. Playing a Video.
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6.7. Albums Page
An album is a group of related pictures, music, videos and docu-
ments. The album has a theme, which sets the mood by displaying 
background graphics. The album can be unshared for your own 
enjoyment, or shared with family, friends or everyone.

The Albums page allows you to view your albums, albums shared 
with family, and albums shared with everyone. If your account blocks 
access, you won’t see albums shared with family. See 6.8.11. Add 
New User.

6.7.1. Displaying the Albums Page
From the Landing page, click Albums (Fig. 45). From one of the 
other pages, click Home in the Main menu, and then select Albums.

6.7.2. Selecting an Album
Selecting an album highlights it, and enables the Slideshow and 
Download buttons near the top of the screen.

To select an album, click it.

 

6.7.3. Viewing an Album
Viewing an album shows its images, videos, music and documents 
(Fig. 46). This is the same view that family, friends and the public see 
if they access your shared album.

To view an album, double-click it.

6.7.4. Filtering Files
Filtering the files specifies which file types will appear.

To filter the files, select All Files, Images, Music or Videos in the 
Media Filter list. The album will only display files of the selected type.

Fig. 46 

Fig. 45 
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6.7.5. Setting the View
Setting the view controls how the album will display files.

To set the view, select Thumbnail or Shuffle in the Views list.

Thumbnail

Thumbnail view displays an image for each file that indicates what 
the file contains. It also shows the file name and caption. See 6.6.2. 
Setting the View.

Shuffle

Shuffle view displays a larger image for each file. It also shows the 
file name and caption. You can flip through the files by clicking the 
image to the left or right of the current file. See 6.6.2. Setting the 
View.

6.7.6. Accessing a File
Double-clicking a file opens or downloads it, as follows:

 ■ An image is displayed within a paused slideshow.

 ■ A video is played.

 ■ A song is played, followed by other songs within the album.

 ■ A document is opened or downloaded, depending on your 
browser settings.

6.7.7. Running a Slideshow
Running a slideshow displays the images within the album, one at 
a time, along with their captions (Fig. 47). Music, videos and docu-
ments are not shown. You can run a slideshow using the Albums 
page, or after displaying an album.

To run a slideshow using the Albums page, select the album, and 
then click Slideshow.

To run a slideshow after displaying an album, click Slideshow. You 
can also run a slideshow by double-clicking an image, and then 
clicking the Play button. The toolbar, illustrated at right (Fig. 47), 
allows you control the slideshow.

 

Fig. 47 
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6.7.8. Playing a Video
Playing a video shows the video. To play a video, double-click it. 
The toolbar, illustrated at right, allows you control the playback (Fig. 
48).

6.7.9. Playing Songs
Playing songs plays the music within the album. Images, videos and 
documents are not played. To play songs after displaying an album, 
click Play All.

You can also play a song by double-clicking it. All the songs in 
the album will autoplay, starting with the selected one. Clicking the 
Amazon.com icon starts an additional browser window with similar 
albums you can purchase. The toolbar, illustrated at right (Fig. 49), 
allows you control the playback.

 

6.7.10. Downloading a File
The album streams compressed images to conserve bandwidth and 
improve performance. An album can be configured to allow those 
viewing it to download original full resolution versions of the files. 
This is especially important if the album contains documents, be-
cause the album lists these files but cannot open them. See 6.4.16. 
Allowing Downloads.

Downloading a file retrieves the original full-resolution version of 
the file. You can download all the files using the Albums page, or 
individual files after displaying an album.

To download all the files using the Albums page, select the album, 
and then click Download. A window lists all the files in the album. 
Click the Download button beside the desired file. Depending on 
your browser settings, you can open the file, download it to a spe-
cific directory, or download it to the default directory.

To download a file after displaying an album, select the file by click-
ing it. You can select multiple files by holding the Ctrl key while click-
ing them. After selecting the files, click Download. A window lists the 
selected files. Click the Download button beside the desired file. De-
pending on your browser settings, you can open the file, download 
it to a specific directory, or download it to the default directory. You 
can also download a document by double-clicking it.

 

Fig. 49 

Fig. 48 
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6.8. Preferences Page
The administrator can set up user, server and administration prefer-
ences. Where noted, some preferences are available to all users. 
Other preferences require administrator permission.

6.8.1. Displaying the Preferences Page
From the Landing page, click Preferences. From one of the other 
pages, click Home in the Main menu, and then select Preferences.

6.8.2. Using the Preferences Page
The Preferences page lists the sets of parameters (Fig. 50). To ex-
pand or collapse the set, click the top level name. For example, 
click User to expand the user preferences. Click it a second time to 
collapse the set.

To save your changes, click Submit.

To restore the saved preferences, click Restore.

 

6.8.3. User
All users can set their user preferences (Fig. 51).

Language

The Language list sets the language for the HipServ Application user 
interface. The selection of languages depends on your region. The 
default language is from your computer’s configuration.

Clear Landing Page Background

Clicking the Clear Landing Page Background button removes the 
image from your Landing page.

Sharing Emails Sender

The Sharing Emails Sender box sets the return email address for 
messages sent by HipServ when you share an album with friends.

Fig. 50 

Fig. 51 
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What to do when a file already exists

The What to do when a file already exists box sets the behavior if you 
copy or move a file to a folder that already contains a file with the 
same name. Choices are:

 ■ Overwrite old file – The new file replaces the old file.

 ■ Keep existing file – The old file is retained, and the new file isn’t 
copied/moved.

 ■ Rename new file – The old file is retained, and the new file is 
copied/moved but renamed.

Share new albums with media players by default

The Share new albums with media players by default list controls 
whether new albums will be shared with media players on your 
home network by default. You can override the setting when you 
create or edit an album.

The media player must support the UPnP-AV (Universal Plug and 
Play - Audio Visual), DLNA (Digital Living Network Alliance) or Win-
dows Media Connect standard. Media players include gaming con-
soles (Xbox 360 and PS3), digital photo frames, iTunes clients, IP 
televisions, networked sound systems (Sonos), digital video players 
(Roku, NETGEAR Digital Entertainer, DLink DSM), and many more.

 ■ No – New albums will not be shared with media players.

 ■ Yes – New albums will be shared with media players.

Share new albums with other family members by de-
fault

The Share new albums with other family members by default list 
controls whether new albums will be shared with other HipServ users 
by default. You can override the setting when you create or edit an 
album.

 ■ No – New albums will not be shared with family.

 ■ Yes – New albums will be shared with family.

Hide help tips

The Hide help tips list controls whether help tips appear when you 
start the HipServ Application.

 ■ No – Help tips appear.

 ■ Yes – Help tips do not appear.
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6.8.4. Diskspace
All users can view the amount of space on the LaCie Internet Space 
2 (Fig. 52).

 ■ Used – The Used field shows how much disk space is occupied.

 ■ Free – The Free field shows how much disk space is available.

 

6.8.5. Change Password
All users can change their password. If you back up your computer 
with DesktopMirror, and you change your password, you will have to 
update DesktopMirror with your new password (see 7.9. Changing 
Account Settings).

Enter your new password in the Password box (Fig. 53), then re-enter 
your new password in the Confirm Password box.

6.8.6. Windows Networking
The administrator can control access through HipServ Folders to 
private MyComputers and MyLibrary folders.

Note that this setting does not control access to FamilyLibrary fold-
ers. A user always has access to these through Explorer/Finder.

Enable Windows Networking

The Enable Windows networking list controls whether users can ac-
cess their private folders through HipServ Folders (Fig. 54).

 ■ Yes – Users can access their private folders through Explorer/
Finder.

 ■ No – Users cannot access their private folders through Explorer/
Finder.

Fig. 52 

Fig. 53 

Fig. 54 
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Workgroup name

The Workgroup name box sets the name of the workgroup. The 
workgroup gives the computers on your home network access to 
the LaCie Internet Space 2 through Explorer/Finder, and to the USB 
printer optionally connected.

6.8.7. Registration
The administrator can change the name of the Internet Space 2 (Fig. 
55). The service provider will automatically ensure the device name 
is unique, and will notify you if you need to try a different name.

Note that if you change the device name, friends and the public 
won’t be able to access shared albums using the links provided 
previously. If you use DesktopMirror, you will have to update the 
HipServ name (see 7.9. Changing Account Settings).

HipServ Name

The HipServ Name box sets the device name for your LaCie Internet 
Space 2.

6.8.8. Notifications
The administrator can set the email address for notifications about 
the LaCie Internet Space 2 (Fig. 56).

Notifications

The Notifications box sets the email address for notifications about 
the LaCie Internet Space 2.

Fig. 55 

Fig. 56 
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6.8.9. LAN connection
The administrator can set IP address information for the LaCie In-
ternet Space 2.

Obtain IP Address Automatically

The Obtain IP address automatically list controls whether the LaCie 
Internet Space 2 obtains a dynamic IP address from the router.

 ■ Yes – The LaCie Internet Space 2 automatically obtains a dy-
namic IP address from the router using DHCP. In most cases, 
use this setting (Fig. 58).

 ■ No – The LaCie Internet Space 2 will use the static IP address 
entered into the Server IP address box. This is rarely required, 
but may improve performance for remote users. Selecting No 
enables the Server IP address, Server netmask, and Gateway 
boxes (Fig. 59).

Fig. 57 

Fig. 58 

Fig. 59 
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DNS Server 1

The DNS server 1 box sets the primary domain name server. This is 
obtained automatically from your router’s DHCP configuration, and 
is provided by your ISP.

DNS Server 2

The DNS server 2 box sets the secondary domain name server. This 
is obtained automatically from your router’s DHCP configuration, 
and is provided by your ISP.

Server IP Address

The Server IP address box sets the static IP address for the LaCie 
Internet Space 2. Obtain the static IP address from your ISP (Internet 
service provider), and use it to replace the dynamic IP address that 
appears in the box by default. The Server IP address box only ap-
pears if Obtain IP address automatically is set to No.

Server Netmask

The Server netmask box sets the subnet mask. Choices are:

 ■ /32 (255.255.255.255)

 ■ netmask.24 (255.255.255.0)

 ■ /16 (255.255.0.0)

 ■ /8 (255.0.0.0)

The subnet mask determines the address range of the subnet. Data 
to addresses within the subnet (e.g. between your computer and 
the LaCie Internet Space 2) are routed within the network. Data to 
addresses outside the subnet (e.g. between a remote user and the 
LaCie Internet Space 2) are routed to the Internet. Most home net-
works with less than 255 nodes use netmask.24. The Server netmask 
box only appears if Obtain IP address automatically is set to No.

Gateway

The Gateway box sets the IP address of the device that routes data 
from the LaCie Internet Space 2 to the Internet (i.e. the router). The 
Gateway box only appears if Obtain IP address automatically is set 
to No.
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6.8.10. Date and Time
The administrator can set the date and time for the LaCie Internet 
Space 2.

Set Date and Time from the Internet

The Set date and time from the Internet list controls where the LaCie 
Internet Space 2 obtains the date and time. Choices are:

 ■ Yes – The LaCie Internet Space 2 obtains the date and time 
from NTP (network time protocol) servers. In most cases, use 
this setting. Selecting Yes enables the Internet Time Servers box 
(Fig. 60).

 ■ No – The administrator sets the date and time for the LaCie In-
ternet Space 2. Selecting No enables the Date and Time controls 
(Fig. 61).

Internet Time Servers

The Internet Time Servers box sets the NTP servers used by the LaCie 
Internet Space 2. In most cases, use the default NTP servers. 

The Internet Time Servers box appears if Set date and time from the 
Internet is set to Yes.

Date

The Date control sets the current date. Set the date by clicking the 
Calendar icon and then choosing the year, month and date. The 
Date control appears if Set date and time from the Internet is set to 
No.

Time

The Time control sets the current time. Set the time using the up and 
down arrows after clicking the hour and minute. The Time control 
appears if Set date and time from the Internet is set to No.

Country

The Country list allows you to select your country.

City

The City list allows you to select a city within your time zone.

Fig. 60 

Fig. 61 
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6.8.11. Add New User
The administrator can add new users. This way each user in your 
family can have their own MyLibrary folders (Fig. 62).

Account User Name

The Account User Name box sets the name of the user. It must be at 
least three characters.

Display Name

The optional Display Name box sets the name that will appear in the 
Main menu of the HipServ Application. The display name will also 
appear in the Albums page before the user’s albums. If used, it must 
be at least three characters.

Password

The Password box sets the user’s password. It must be at least six 
characters, and one of the characters must be a digit.

Confirm Password

Re-enter the password in the Confirm Password box.

Create as Administrator

Selecting the Create as Administrator check box gives the user ad-
ministrator permissions. The default setting denies administrator per-
missions.

 ■ A user with administrator permissions has access to all the pref-
erences.

 ■ A user without administrator permissions only has access to the 
User, Diskspace and Change Password preferences.

Let User Access Family Folder

Selecting the Let user access family folder check box gives the user 
access to the FamilyLibrary folders, and allows them to view albums 
that have been shared with family. The default setting grants access.

Note that if you disable access to the FamilyLibrary folders, a user 
can still access them using Explorer/Finder through HipServ Folders.

Fig. 62 
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6.8.12. Edit User
The administrator can edit user accounts (Fig. 63).

Account User Name

The Account User Name list contains the users added previously, 
and allows you to select the account to edit.

Display Name

The optional Display Name box sets the name that will appear in the 
Main menu of the HipServ Application. The display name will also 
appear in the Albums page before the user’s albums. If used, it must 
be at least three characters.

Password

The Password box sets the user’s password. It must be at least six 
characters, and one of the characters must be a number.

If you’re editing your own administrator account, you must re-enter 
the password, even if you’re not changing it. 

If the user backs up their computer with DesktopMirror, they will 
have to update DesktopMirror with their new Password (see 7.9. 
Changing Account Settings).

Confirm Password

Re-enter the password in the Confirm Password box.

Create as Administrator

Selecting the Create as Administrator check box gives the user ad-
ministrator permissions.

 ■ A user with administrator permissions has access to all the pref-
erences.

 ■ A user without administrator permissions only has access to the 
User, Diskspace and Change Password preferences.

Let User Access Family Folder

Selecting the Let user access family folder check box gives the user 
access to the FamilyLibrary folders, and allows them to view albums 
that have been shared with family.

Note that if you disable access to the FamilyLibrary folders, a user 
can still access them using Explorer/Finder through HipServ Folders.

Fig. 63 
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6.8.13. Shut Down
The administrator can shut down or restart the LaCie Internet Space 
2 (Fig. 64).

To shutdown the LaCie Internet Space 2, click Shutdown.

To restart the LaCie Internet Space 2, click Restart.

 

6.8.14. Software Updates
The administrator can check for firmware updates to the LaCie In-
ternet Space 2.

To check for firmware updates, click the Check Now button (Fig. 
65). If there are no updates, Your HipServ is up-to-date appears.

 

6.8.15. USB
Use this section to manage attached external USB hard drives (Fig. 
66).  You will see information about an attached drive, as well as the 
option to format or eject the drive.  For details on using an external 
USB hard drive to back up your Internet Space 2, see section 8. 
Backup onto USB Disk.

 

6.8.16. Computers Backup
The Internet Space 2 can be used to back up your computer if you 
are using Windows Backup or Time Machine (Fig. 66).  From this 
section, activate the service by clicking the check box and creating a 
password.  Once activated, the service will allow the Internet Space 
2 to be a valid backup destination for these backup applications.

 

Fig. 64 

Fig. 65 

Fig. 66 

Fig. 67 
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DesktopMirror lets you back up the PCs and Macs on your home 
network onto the LaCie Internet Space 2 (Fig. 68). The DesktopMir-
ror application backs up selected folders on a regular basis. Vista 
Backup and Time Machine can use the LaCie Internet Space 2 as 
the backup disk. Backed up content is always available, even if the 
computer is turned off.

Note that the directory structure within the MyComputers folder 
makes it easy to locate and restore single files or entire folders.

DesktopMirror will back up the files in one direction, from the com-
puter to the LaCie Internet Space 2. It will back up the files in the list-
ed folders, using the settings in the Schedule tab. Files that haven’t 
changed since the last backup will be ignored. New and updated 
files on the computer will be copied to the LaCie Internet Space 2. 
Deleted files will be removed from the LaCie Internet Space 2.

 

7. DesktopMirror (Backup Application)

Fig. 68 
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7.1. Starting DesktopMirror
During the setup process in chapter 2, you installed HipServ Agent, 
which provides you a quick way to launch the other HipServ soft-
ware, including the Desktop Mirror.

1. To launch Desktop Mirror:

Windows Users: Click the HipServ icon in the System Tray 
and select Open HipServ DesktopMirror.

Mac Users: Click on the HipServ icon in the Menu Bar and 
select Open HipServ DesktopMirror.

Alternatively you can launch DesktopMirror in this way:

Windows Users: Navigate to Start > All Programs > Axen-
tra > HipServ Desktop Applications > Desktop Mirror > 
Desktop Mirror.

Mac Users: Navigate to Applications > HipServ Desktop 
Applications, and then launch Desktop Mirror.

Folders that have never been backed up are red. Folders to be 
backed up are yellow. Folders that have been successfully backed 
up are green.
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7.2. Configuring Backup
When you first start DesktopMirror, you must configure it. If your 
computer has multiple users, then each user must start DesktopMir-
ror and configure backup separately.

1. Enter the HipServ Name (if required), User Name and Password, 
and then click Next. If you log in to the HipServ Application us-
ing these credentials, the backup directory for the computer will 
appear under MyComputers.

2. The My Documents (PC) or Documents (Mac) folder is selected 
for backup. Click Next.

3. If Windows Firewall is blocking HipServ DesktopMirror, click 
Unblock.

4. Select when to back up files, and then click Next. Backup can 
occur when an interval expires, or at a certain time daily or 
weekly, and when you start DesktopMirror.

5. Optionally select Start backing up my folders when I click finish, 
and then click Finish. The HipServ DesktopMirror window shows 
the status of the backup.

7.3. Adding Folders to the Backup
Adding a folder will include the folder, its files, and its subfolders in 
the subsequent backups.

To add a folder, choose File > Add, or click the Add icon ( ). 
Browse for the folder you want to add, and then click OK.

7.4. Removing Folders from the 
Backup

Removing a folder will exclude the folder, its files, and its subfolders 
from subsequent backups. It will be deleted from the LaCie Internet 
Space 2 when backup next runs.

To remove a folder, select the folder to remove from the backup. 
Choose File > Remove, or click the Remove icon ( ). Click OK 
to confirm.
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7.5. Viewing the Report
A report is generated after every backup or restore event. The report 
is added to the top of the Backup Activity log. Viewing the report 
shows the most recent addition to the log.

To view the report, choose View > View Report. The Backup Activity 
window appears (Fig. 69).

 

7.6. Manually Backing Up Selected 
Folders

After you add folders to the backup, you can manually back up 
selected folders.

To manually back up selected folders, select the folders to backup. 
You can select multiple folders by holding the Ctrl key while clicking 
folders. Choose Tools > Backup Selected Item(s). New and modi-
fied files in the selected folders are backed up.

7.7. Manually Backing Up all Listed 
Folders

After you add folders to the backup, you can manually back up all 
listed folders.

To manually back up all listed folders, choose Tools > Backup All 
Items. New and modified files in all listed folders are backed up.

7.8. Restoring all Backed Up Folders
Restoring all backed up folders copies their files to the computer.

To restore all backed up folders, choose Tools > Restore. Files and 
folders on the HipServ are added to or replace those on the com-
puter.

Note that you can easily restore a single file by downloading it 
through the HipServ Application, or by copying and pasting it 
through HipServ Folders.

Fig. 69 
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7.9. Changing Account Settings
Changing accounts settings lets you modify the device name, user 
name, password, and backup schedule.

To change account settings, choose Tools > Account Settings.

 

7.10. Identity Tab
Select the Identity tab to modify the HipServ host name, User name 
or Password (Fig. 70).

This is required if you change the device name (see 6.8.7. Registra-
tion), or if a user changes their password (see 6.8.12. Edit User).

7.11. Schedule Tab
Select the Schedule tab to modify when to back up files (Fig. 71).

If you select Timed Backup, DesktopMirror backs up the files auto-
matically. You can select Backup every or Backup at. Backup ev-
ery lets you select the duration between backups, ranging from 5 
minutes to 24 hours. Backup at lets you select the time and day for 
the backup. If you select Backup at program startup, DesktopMirror 
backs up the files when started. This way you control when backups 
occur.

7.12. Advanced Tab
Select the Advanced tab to view the backup folder on the LaCie 
Internet Space 2 (Fig. 72).

 

Fig. 70 

Fig. 71 

Fig. 72 
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7.13. Synchronization Mode
You can use DesktopMirror’s Synchronization Mode to copy files 
both ways – from your Internet Space 2 to your computer and from 
your computer to the Internet Space 2.

Using synchronization, if you back up a folder using DesktopMirror, 
and then upload additional files to that folder, the files will  be cop-
ied automatically to your computer.

For example, let’s say you’re traveling with your laptop and you 
buy a new music CD, which you rip onto your MyMusic folder on 
your laptop.  Assuming that you’ve already set up a DesktopMirror 
scheduled backup to back up your laptop’s MyMusic folder, Syn-
chronization Mode will copy the new files onto the Internet Space 2 
when you run DesktopMirror.

Synchronization works both ways, so, to continue the previous ex-
ample, if someone at home copied music files to the Internet Space 
2, when you run DesktopMirror, those files will be copied to your 
laptop.

If you set up a scheduled backup (see 7.11. Schedule Tab), this 
process will be automatic; otherwise you have to run DesktopMirror 
to execute the synchronization.



LaCie Internet Space 2 Backup onto USB Disk
User Manual page 67

The Internet Space 2 allows you to connect an external USB hard 
drive in order to back up files located on the Internet Space 2. Using 
this feature, if files on the Internet Space 2 are damaged or acciden-
tally deleted, you can restore them to their original locations.

Additionally, if you are using Windows Backup or Time Machine, 
you can back up your computer onto the Internet Space 2.  This 
chapter will discuss backing up the Internet Space 2 onto an external 
USB hard drive; for details on activating the Windows Backup or 
Time Machine service, see section 6.8.16. Computers Backup.  This 
chapter consists of the following sections:

 ■ 8.1. External Hard Drive: Connection

 ■ 8.2. External Hard Drive: Backup

 ■ 8.3. External Hard Drive: Restoring Files

 ■ 8.4. External Hard Drive: Disconnection

8. Backup onto USB Disk



LaCie Internet Space 2 Backup onto USB Disk
User Manual page 68

8.1. External Hard Drive: Connection
Before you can back up files, you need to connect a hard drive to 
your Internet Space 2 via the USB port on the back. LaCie recom-
mends that you use a hard drive that is USB 2.0 compatible.

TECHNICAL NOTE: The Internet Space 2 is not compatible with 
external hard drives using HFS+ (Macintosh) format. Connect a 
drive formatted in NTFS or MS-DOS (FAT32). Refer to your external 
hard drive’s user documentation for information about the file sys-
tem format.

1. Make sure your Internet Space 2 is turned on and connected to 
your network.

2. Connect the external USB hard drive’s power cable (if it has 
one) and turn it on (if applicable).

3. Connect the external hard drive’s USB cable to the USB port on 
the back of the Internet Space 2, just like you would connect the 
external hard drive to your computer (Fig. 73).

4. Confirm that the drive is properly connected. Log in to HipServ 
Application (Web Portal) and click on the Administer HipServ 
link. Click on USB under System (Fig. 74).  If an error message 
appears, the drive must be formatted.  You can format a con-
nected drive by clicking the Format button next to the drive’s 
listing.

Fig. 73 

Fig. 74 
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8.2. External Hard Drive: Backup
From the Landing Page, click the Backup link. Move the mouse over 
the folder you wish to back up, then click the gray arrow button, then 
select USB Backup > Add to Backup (Fig. 75).

When you back up files to an external hard drive, the Internet Space 
2 duplicates the file path onto the external drive so that everything 
you back up is organized in Backup just as in its original location.

So, if you copy a file from MyLibrary, a MyLibrary folder will appear 
in Backup, with all folders leading to the backed up file.

To initiate the backup, click the Backup Now button (Fig. 76).

NOTE: Click the gray arrow button next to a file or folder icon to 
display a menu that tells you whether the file or folder has already 
been backed up in Backup.

8.3. External Hard Drive: Restoring 
Files

If you accidentally delete files from your Internet Space 2 or if you 
make modifications to files that you want to undo, you can restore 
backed up files on your external hard drive to their original locations 
on the Internet Space 2 with just a couple of clicks. Click the Restore 
button (Fig. 77) to begin the process.

8.4. External Hard Drive: 
Disconnection

Navigate to Preferences > Administration > USB and click the Eject  
button next to the drive.

CAUTION: Failure to safely remove your external hard drive before 
disconnecting the USB cable can cause data loss and/or damage 
the drive. Always use the Safely Remove Drive feature when discon-
necting an external hard drive.

Fig. 75 

Fig. 76 

Fig. 77 
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9.1.  iTunes
Computers can use iTunes to access music stored in the iTunes li-
brary on the LaCie Internet Space 2. These iTunes clients must be 
connected to the same home network as the LaCie Internet Space 2. 
They cannot access the iTunes library remotely across the Internet.

9.2. Adding Songs to the iTunes 
Library

The LaCie Internet Space 2 can stream music from the iTunes library 
to the iTunes clients on your home network.

Adding songs to the iTunes library makes them available to the 
iTunes clients.

To add songs to the iTunes library, first move the music files to sub-
folders within FamilyLibrary > FamilyMusic (Fig. 78). After moving 
the music files, ensure the folder is shared. Select the FamilyMusic 
folder, and display the menu. If the Unshare with DMA command is 
displayed, the folder is shared. If the Share with DMA command is 
available, select it.

9.3. Configuring an iTunes Client
Configuring an iTunes client ensures it will look for shared libraries, 
including the FamilyMusic folder on the LaCie Internet Space 2.

To configure an iTunes client, choose Edit > Preferences, and then 
select the Sharing tab. Ensure that Look for shared libraries is se-
lected (Fig. 79).

9. Other Services

Fig. 78 

Fig. 79 
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9.4. Playing Songs with an iTunes 
Client

Music files stored on the LaCie Internet Space 2 appear in iTunes 
under the SHARED heading and the HipServ:iTunes folder. You can 
play these songs within iTunes, but you cannot add them to a play-
list. Pictures, videos and documents stored on the LaCie Internet 
Space 2 are not available within iTunes.

Up to five iTunes clients on your home network (i.e. computers and 
media players) can play iTunes DRM-protected music, but an unlim-
ited number of iTunes clients can play iTunes Plus music or songs 
imported from CD.

To play music, select the HipServ:iTunes folder, and then double-
click the song.

9.5. HipServ Pictures Wizard
The HipServ Pictures Wizard uploads images directly to the LaCie 
Internet Space 2. It starts when you attach a digital camera to your 
PC. It also starts if you insert a memory card into your PC.

The wizard allows you to choose the destination folder for the im-
ages, whether to rename the files, and whether to delete the images 
from the camera.

The HipServ Pictures Wizard is available on a PC only, and the PC 
must be on the same home network as the LaCie Internet Space 2.

 

Fig. 80 



LaCie Internet Space 2 Troubleshooting
User Manual page 72

In the event that your LaCie Internet Space 2 is not working correctly, 
please take a look at the following Troubleshooting sections and at 
the FAQs published on our web site – www.lacie.com. One of these 
FAQs may provide an answer to your specific question. You can also 
visit the downloads page, where the most recent software updates 
will be available:

www.lacie.com/support/downloads.

If you need further assistance, please contact your LaCie reseller or 
LaCie Technical Support (see section 11.1. LaCie Technical Support 
Contacts for details).

10.1. Manual Updates
LaCie strives to give you the most up-to-date, comprehensive user 
manuals possible. It is our goal to provide you with a friendly, easy-
to-use format that will help you quickly install and utilize the many 
functions of your new device.

If your manual does not reflect the configurations of the product 
that you purchased, please check our website for the most current 
version available.

www.lacie.com

 

10. Troubleshooting
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Problem Solution

My ports 80, 22 are not opened and I cannot set up the Internet 
Space 2.

Refer to your router’s documentation and unblock these ports.

My ports 1194 and 443 are not opened and I cannot access my 
Internet Space 2 remotely.

Refer to your router’s documentation and unblock these ports.

I’m trying to sign in to www.homelacie.com and I am getting an error 
message.

Make sure the Internet Space 2 is switched on and connected to the 
internet.

I’m trying to sign in to www.homelacie.com and my username/pass-
word is rejected.

Make sure your are typing your username and password correctly: 
both are case-sensitive.  (I.e. “MichaelScott” is different than “mi-
chaelscott”)

I am not able to set up my Internet Space 2 even though all the re-
quired ports are unblocked.

Make sure the computer you used for setup is correctly connected to 
the internet.  An internet connection is required for setup.

I cannot access my Internet Space 2 via the web portal while it is con-
nected to the internet and is turned on.

Reboot your Internet Space 2.  Press the power button on the back to 
turn it off, and once the blue light has stopped blinking, restart it by 
pushing the power button.
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Before You Contact Technical Support

1. Read the manuals and review section 10. Troubleshooting.

2. Try to isolate the problem. If possible, make the drive the only 
external device on the CPU, and make sure that all of the cables 
are correctly and firmly attached.

If you have asked yourself all of the pertinent questions in the trou-
bleshooting checklist, and you still can’t get your LaCie drive to work 
properly, contact us at www.lacie.com. Before contacting us, make 
sure that you are in front of your computer and that you have the 
following information on hand:

Information Location

1. LaCie hard drive serial 
number

Located on a sticker next to 
one of the product feet.

2. Macintosh/PC model Mac users: Click on the 
Apple icon in the menu bar 
and select About This Mac.

Windows users: Right click 
My Computer and select 
Properties > General.

3. Operating system version

4. Processor speed

5. Computer memory

6. The brands and models 
of other internal and 
external peripherals in-
stalled on your computer 

Mac users: Click on the 
Apple icon in the finder bar 
and select About This Mac.  
Select More Info...  The Ap-
ple System Profiler will launch 
and will list your internal and 
external peripherals.

Windows users: Right click 
My Computer and select 
Properties > Hardware.

 

11. Contacting Customer Support
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11.1. LaCie Technical Support Contacts

LaCie Asia
Contact us at:
http://www.lacie.com/asia/contact/

LaCie Australia
Contact us at:
http://www.lacie.com/au/contact/

LaCie Belgium
Contact us at:
http://www.lacie.com/be/contact/ (Français)

LaCie Canada
Contact us at:
http://www.lacie.com/caen/contact/ (English)

LaCie Denmark
Contact us at:
http://www.lacie.com/dk/contact

LaCie Finland
Contact us at:
http://www.lacie.com/fi/contact/

LaCie France
Contact us at:
http://www.lacie.com/fr/contact/

LaCie Germany
Contact us at:
http://www.lacie.com/de/contact/

LaCie Italy
Contact us at:
http://www.lacie.com/it/contact/

LaCie Japan
Contact us at:
http://www.lacie.com/jp/contact/

LaCie Netherlands
Contact us at:
http://www.lacie.com/nl/contact/

LaCie Norway
Contact us at:
http://www.lacie.com/no/contact/

LaCie Spain
Contact us at:
http://www.lacie.com/es/contact/

LaCie Sweden
Contact us at:
http://www.lacie.com/se/contact

LaCie Switzerland
Contact us at:
http://www.lacie.com/chfr/contact/ (Français)

LaCie United Kingdom
Contact us at:
http://www.lacie.com/uk/contact

LaCie Ireland
Contact us at:
http://www.lacie.com/ie/contact/

LaCie USA
Contact us at:
http://www.lacie.com/contact/

LaCie International
Contact us at:
http://www.lacie.com/intl/contact/
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This Limited Warranty applies only to hardware products manufac-
tured by or for LaCie that can be identified by the “LaCie” trademark, 
trade name, or logo affixed to them. The Limited Warranty does not 
apply to any non-LaCie hardware products or any software, even if 
packaged or sold with LaCie hardware. Manufacturers, suppliers, 
or publishers, other than LaCie, may provide their own warranties 
to the end user purchaser, but LaCie, in so far as permitted by law, 
provides their products “as is”. Software distributed by LaCie with or 
without the LaCie brand name (including, but not limited to system 
software) is not covered under this Limited Warranty. Refer to the 
licensing agreement accompanying the software for details of your 
rights with respect to its use.

LaCie does not warrant that the operation of the product will be un-
interrupted or error-free. LaCie is not responsible for damage arising 
from failure to follow instructions relating to the product’s use. This 
warranty does not apply:

 ■ to consumable parts, unless damage has occurred due to a de-
fect in materials or workmanship;

 ■ to cosmetic damage, including but not limited to scratches, 
dents and broken plastic on ports;

 ■ to damage caused by use with non-LaCie products;

 ■ to damage caused by accident, abuse, misuse, flood, fire, earth-
quake or other external causes;

 ■ to damage caused by operating the product outside the permit-
ted or intended uses described by LaCie;

 ■ to damage caused by service (including upgrades and expan-
sions) performed by anyone who is not a representative of LaCie 
or a LaCie Authorized Service Provider;

 ■ to a product or part that has been modified to alter functionality 
or capability without the written permission of LaCie; or

 ■ if any LaCie serial number on the product has been removed or 
defaced.

To obtain warranty service, call LaCie Technical Support. You will 
be asked to provide your LaCie product’s serial number, and you 
may be asked to furnish proof of purchase to confirm that the drive 
is still under warranty.

All drives returned to LaCie must be securely packaged in their origi-
nal box and shipped with postage prepaid.

IMPORTANT INFO: Register online for free technical support: 
www.lacie.com/register
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